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PROXY Pro overview

Thank you for selecting PROXY™ Pro remote desktop solutions.

PROXY Pro remote desktop solutions provide professional features that enable helpdesk
technicians, network administrators, IT managers, and software trainers to deliver
professional remote support for a fraction of the cost of hosted solutions.

Some selected features include:

€ Remote Access: Reach anyone, anywhere, anytime using firewall- and NAT-friendly
remote control connections.

€ Remote Control: Diagnose and resolve support issues without having to physically
visit remote computer.

€ Remote Management: Repair remote computers and make configuration changes in
real-time and without disturbing currently logged-on user.

4 Collaboration: Enable two or more technicians to work on the same remote computer
at the same time using chat, screen-sharing and easy-to-pass remote support.

NOTE: Before you use PROXY Pro remote desktop solutions, you should be familiar with
basic network concepts, such as protocols, encryption, IP addresses, ports, and subnets.

To learn more about PROXY Pro remote desktop solutions, see:
"What's New"

"PROXY Pro solutions"

"PROXY Pro applications"

"PROXY Pro technologies”

"PROXY Pro services"

"PROXY Pro connection types"

"PROXY Pro security features"

"PROXY Pro networking features"

® 6 6 6 O O O 0 o

"PROXY Pro documentation and technical support"
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What’s New with PROXY Pro 7.0

PROXY Pro 7.0 introduces the following new features and capabilities:

& Terminal Services Host configuration: The Root Host can be configured to restrict
the injection of a Host image to Terminal Services sessions that meet predetermined
criteria (previously, the Root Host injected a Host image into every TS session). The
criteria for determining which TS sessions should receive a Host image are available on
the Terminal Services tab in the Root Host control panel.

€ Windows 7 support: PROXY Pro 7.0 provides full support (remote access, remote
control, remote management) for Windows 7 computers, including 32- and 64-bit
platforms.

€ Windows Server 2008 R2 support: PROXY Pro 7.0 provides full support (remote
access, remote control, remote management) for Windows Server 2008 R2 computers
(64-bit platforms only).

€ Mac, Linux support: PROXY Pro 7.0 provides support (remote access, remote
control) for Macintosh and Linux computers running VNC server software (standard on
Macs).

€ Wake-on-LAN support: PROXY Pro 7.0 includes ability to turn on remote computers
that are configured to listen for Wake-on-LAN signal.

& Remote Power Scheme management: PROXY Pro 7.0 includes new remote
management tools that allows Master user to view and change power scheme settings on
remote computers.

€ Screen Recording Playback via URL: PROXY Pro 7.0 includes ability for Master to
playback a PROXY Pro screen recording from a standard web server over HTTP or
HTTPS.

& RDP compatibility: If a remote computer is hosting an active RDP session, PROXY
Pro 7.0 Host will capture and provide input control to the RDP session.

& Active Directory integration: PROXY Pro 7.0 Deployment Tool can now be used to
discover computers and OUs in Active Directory domains, install new PROXY Pro
software, upgrade existing software, and/or push configuration changes to existing
software.

What’s New with PROXY Pro 6.10

¢ Remote Management service: PROXY Pro 6.10 features a new service that allows
Master user to generate inventory of hardware and software assets on a remote Host.
Also allows Master user to query and change certain system settings.

€ Terminal Services support: PROXY Pro 6.10 supports server-side Hosts for thin
client, terminal services sessions for Citrix XenApp (formerly Citrix Presentation Server)
and Windows Terminal Server.

€ User-Mode Screen Capture optimization: PROXY Pro 6.10 includes significant
performance and reliability enhancements for user-mode screen capture technology
introduced in PROXY Pro 6.0.

What's New with PROXY Pro 6.0
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PROXY Pro 6.0 introduced the following new features and capabilities:

€ Windows Vista and Server 2008 support: PROXY Pro 6.0 applications (Host,
Master, Gateway, Deployment Tool) now run on Windows Vista and Windows Server
2008 operating systems.

NOTE: PROXY Pro 6.0 introduces a new screen capture technology (user-mode) for
Windows Vista and Windows Server 2008 platforms.

4 Bandwidth throttling: PROXY Pro 6.0 allows screen capture settings to be modified
in order to reduce the amount of bandwidth used. Usually, this will reduce screen capture
quality but improve responsiveness and overall performance (see PROXY Pro Host
Guide for more information).

€ Popup notifications: PROXY Pro 6.0 supports popup "toast" notifications when
connections are established to remote computers (see PROXY Pro Host Guide for more
information).

& Send keystroke button: PROXY Pro 6.0 now provides a new toolbar button on the
Master Connection Window, which can be configured to send Ctrl+Alt+Del or one of the
other available keyboard combinations to remote computer (see PROXY Pro Master
Guide for more information).

& Host-based chat: PROXY Pro 6.0 introduces support for Host-based chat. This new
service automatically creates a private chat room including Host user and any technicians
connected to the Host. Technicians can see and participate in multiple chat rooms
simultaneously (see PROXY Pro Master Guide for more information).

& File transfer resume: Occasionally, a file transfer operation is interrupted when a
connection is lost. PROXY Pro 6.0 introduces the ability to resume interrupted file
transfers exactly from the point of interruption (see PROXY Pro Master Guide for more
information).

¢ Windows Media format support: PROXY Pro screen recording files are produced in
a streamlined, proprietary format and play back in a viewer provided with PROXY Pro
Master. PROXY Pro 6.0 introduces a new utility to enable technicians to convert PROXY
Pro screen recording files into Windows Media format for play back in WM-compatible
players and editing in off-the-shelf media tools (see PROXY Pro Master Guide for more
information).
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PROXY Pro solutions

Proxy Networks provides two solutions for remote desktop support:

PROXY Pro Workstation Edition

PROXY Pro Workstation Edition is an easy-to-use remote desktop solution that uses
simple peer-to-peer connections between helpdesk technicians and end-user remote
computers. It is ideally suited for smaller companies and workgroups in which the number
of remote computers being supported is small and manageable.

PROXY Pro Gateway Edition

PROXY Pro Gateway Edition is an enterprise-class remote desktop solution that uses a
robust, scalable server to establish and maintain a secure network of connections to end-
user machines. It leverages centralized administration, security and network access to
simplify and automate the creation, management, and monitoring of this “network within a
network”. PROXY Pro Gateway Edition is ideally suited for enterprises and corporate
workgroups with large numbers of remote computers, multiple domains and/or
employees with remote computers outside the network.

PROXY Pro PROXY Pro
PROXY Pro Features Workstation Gateway
Edition Edition
Components
PROXY Pro Host Yes Yes
PROXY Pro Master Yes Yes
PROXY Pro Gateway No Yes
PROXY Pro Deployment Yes Yes
Tool
Connection Types
Peer-to-peer
connections ves ves
Gateway—managed No Yes
connections
Flrewalljfrlendly No Yes
connections
Termlna_l services No Yes
connections
VNC connections Yes No
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PROXY Pro applications

The PROXY Pro remote desktop solutions include some or all of the following
applications:

PROXY
PROXY Pro PROXY Pro Pro
o Workstation
Applications . Gateway
Edition .
Edition
PROXY Pro Host Yes Yes
PROXY Pro Master Yes Yes
PROXY Pro Gateway No Yes
PROXY Pro Yes Yes

Deployment Tool

PROXY Pro Host

PROXY Pro Host is an agent application that enables remote support connections to be
established to the machine on which it runs. By installing PROXY Pro Host on a
computer in your network, you can:

4 Allow technicians to make peer-to-peer remote control connections to the machine,
whether someone is there or not. Each Host manages its own security settings and
access rights.

@ Allow or force technicians to make Gateway-managed remote support connections to
the machine through a central server (PROXY Pro Gateway), which will automatically
enforce security settings and access rights according to policies set at the server.

PROXY Pro Host can now be installed in server-side terminal sessions for application
virtualization solutions such as Citrix XenApp and Microsoft Terminal Server.

For more information about configuring and operating PROXY Pro Host, please see the
PROXY Pro Host Guide.

PROXY Pro Master

10
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PROXY Pro Master is a console application that technicians can use to establish remote
support connections to one or more Host computers. With PROXY Pro Master, you can:

€ Make one or more peer-to-peer remote support connections to Host computers in your
network.

4 Connect to PROXY Pro Gateway and make one or more Gateway-managed remote
support connections to Host computers from a directory of available Hosts.

& View the entire screen of the remote computer.

& Take complete control of a Host computer using the local keyboard and mouse.
€ Share control of the Host computer with its end-user.

4 Passively monitor the Host computer without exercising control.

4 Use the clipboard transfer feature to transfer portions of text, bitmaps, and other
objects between your Host and Master computers.

€ Use the PROXY Pro file transfer feature to copy files between your Host and Master
computers.

€ Use the PROXY Pro remote printing feature to print locally from applications running
on a remote computer.

€ Record screen activity on the Host and play back the recording on the Master.
4 Chat with end-user and any other technicians connected to the same Host.

For more information about configuring and operating PROXY Pro Master, please see
the PROXY Pro Master Guide.

PROXY Pro Gateway

PROXY Pro Gateway is an enterprise class server, which provides centralized
administration, security and management for a network of remote support connections to
Host computers in your environment.

With PROXY Pro Gateway configured as the hub of your remote support network, you
can:

4 Organize large numbers of Host computers into logical groups for easier access and
management.

& Reach remote computers outside the network, behind firewalls or NAT-devices.
& Utilize SSL for certificate-based authentication.

& Create custom access rights policies and apply them to groups to make configuration
changes more quickly and efficiently.

11
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4 Monitor and manage remote support activity in real-time.

& Keep detailed records of all remote support activity in your network with
comprehensive audit logs.

€ Record screen activity on one or more remote computers simultaneously using
PROXY Pro Gateway’s screen recording feature.

PROXY Pro Gateway includes the PROXY Pro Gateway Administrator, a tool for
configuring the Gateway and for monitoring, managing and auditing remote support
activity in your network.

For more information about configuring and operating PROXY Pro Gateway, please see
the PROXY Pro Gateway Administrator Guide.

PROXY Pro Deployment Tool

PROXY Pro Deployment Tool is an easy-to-use software distribution utility that
automates the deployment and installation of PROXY Pro applications to remote
computers in your network.

With PROXY Pro Deployment Tool, you can:

4 Automatically deploy an image of PROXY Pro Host, Master or Gateway to one or
more computers or groups of computers in your network and avoid manual effort of going
to each machine.

& Create an image of PROXY Pro Host, Master or Gateway with custom configuration
options that can be mass deployed on large numbers of computers in your environment.

4 Create and push custom configuration options for PROXY Pro Host, Master or
Gateway, without having to reinstall underlying software.

€ Use Active Directory to find remote computers and push software and configuration
settings to them.

For more information about configuring and operating PROXY Pro Deployment Tool,
please see the PROXY Pro Deployment Tool Guide.

12
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PROXY Pro technologies

PROXY Pro remote desktop solutions utilize highly optimized technologies to deliver
speed, performance and reliability, including:

& Highly efficient screen capture algorithms. PROXY Pro utilizes two kinds of screen
capture technology:

+ Kernel-mode screen capture for Windows XP, Windows Server 2003 and older
platforms. This technology utilizes the PROXY Pro mirror driver, which reproduces
graphics drawing commands from the remote Host on the PROXY Pro Master user’s
screen quickly and efficiently.

+ User-mode screen capture for Windows Vista and Windows Server 2008 remote
computers. This technology works without a mirror driver and is designed to adjust
automatically to the amount of CPU and bandwidth available on the remote Host
machine.

€ Streamlined communication protocol. The PROXY Pro protocol has been honed
over 15 years for efficiency and reliability when sending screen capture data to another
computer in real-time and receiving keyboard/mouse input.

Using these technologies, PROXY Pro remote support solutions enable technicians to
find and fix problems on remote computers faster and easier than ever before.

13
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PROXY Pro services

PROXY Pro remote desktop solutions offer technicians a number of professional-quality
services for investigating and solving problems on Host remote computers, including:

€ Remote Control: ability to view screen activity on an end-user’s remote machine, and
with proper authorization, take control of and send keyboard/mouse inputs to the remote
machine in real-time

& Remote Clipboard: ability to copy selected items on the screen of a remote machine
into the clipboard on the remote machine and transfer the contents to the clipboard on
the technician’s machine, and vice versa

& File Transfer: ability to drag-and-drop files or directories on the remote machine to
the technician’s machine, and vice versa

€ Host-based Chat: ability to chat with the end-user on a remote machine, and any
other technicians connected to that machine

€ Remote Printing: ability to print selected items from the remote machine to a printer
attached to the technician’s machine

4 Host Administration: ability to view and edit configuration settings of the PROXY Pro
Host installed on the remote machine

¢ Remote Management: ability to generate inventory of hardware and software assets
on remote machine, and to query and change certain system settings. See "Remote
Management features" for more information about tools available through this service.

Remote Management features

PROXY Pro provides tools to enable technicians to generate inventory of hardware and
software assets on a remote computer, and to view/modify configuration settings.

Remote management tools include:

& Hardware Manager: provides a graphical view of physical devices and resources
available on the remote Host computer.

& Software Manager: provides a graphical view of the software applications that are
installed on the remote Host computer

€ System Manager: provides a graphical view of various configuration settings on the
remote Host computer.

€ Shared Resource Manager: provides a graphical view of currently available shared
resources (Shares) and any current network users with connections (Sessions) to the
remote Host computer to access the shared resources.

& Account Manager: provides a graphical view of currently available user, group and
system accounts on the remote Host computer.

& Service Manager: provides a graphical view of and ability to start/stop/restart
currently available services and system drivers on the remote Host computer.

€ Process Manager: provides a graphical view of and ability to stop currently running
processes on the remote Host computer.

€ Registry Manager: provides a graphical view of and ability to create/modify/delete
Registry keys on the remote Host computer.

14
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& Event Manager: provides a graphical view of the Application, Security and System
logs kept on the remote Host computer.

& Power Manager: provides a graphical view of the power management and power
scheme management options for the remote Host computer, as well as ability to restart,
reboot or shutdown the remote computer.

For more information, see PROXY Pro Master Guide.

15
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PROXY Pro connection types

PROXY Pro services are performed over service connections between a PROXY Pro
Master (with appropriate access rights) and a PROXY Pro Host. Service connections are
established on demand, when a PROXY Pro Master requests a service from a PROXY
Pro Host.

PROXY Pro supports several different types of remote access connections:

PROXY Pro PROXY Pro

Connection Types Workstation  Gateway

yp Edition Edition
Peer-to-_peer Yes ves
connections
Gateway-managed No Ves
connections
Firewall-friendly No Ves
connections
Terminal services No Ves
connections
VNC connections Yes No

RDP compatibility: Follow the active session
PROXY Pro connections can be used to share an active RDP session in real-time.

If PROXY Pro Host is running on a desktop-class operating system (e.g. Windows XP or
Vista), and there is an active/connected RDP session being hosted on that computer,
then the Host will automatically capture and provide input control to that RDP session. In
essence, the Host will capture what the remote RDP session user is seeing, not what the
local physical console on that machine is showing (probably the Windows login screen).

When there is no active/connected RDP session being hosted on that computer, or if an
active/connected RDP session is stopped, the Host will automatically capture and provide
input control to the session running on the computer and being displayed on the local
console. The Host will follow the active session as it moves from RDP user back to the
local console.

Note: This feature only applies to desktop-class operating systems, which support only
one active session at a time. Server-class operating systems (e.g. Windows Server 2003
or Server 2008) can support multiple sessions simultaneously via Terminal Services; use
the Terminal Services support in the Host to capture and/or provide input control to one
or more sessions on server-class OS.

Wake-on-LAN support

PROXY Pro can be used to "wake-up" remote computers that have been shut down
(sleeping, hibernating, or soft off; i.e., ACPI state G1 or G2), with power reserved for the
network card, but not disconnected from its power source. The network card listens for a

16
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specific packet containing its MAC address, called the magic packet, that is broadcast on
the subnet or LAN.

In order to execute this feature, both the MAC address and the last known IP address of
the remote computer must be known. Since the PROXY Pro Gateway knows both of
these pieces of information, it is in a position to send the Wake-on-LAN signal.

PROXY Pro implements this functionality in Gateway-managed connections in two ways:

& Implicit Wake-on-LAN: If Gateway is asked to make a connection to a remote
computer and the last status indicates that the remote computer is "Offline", the Gateway
will automatically attempt to wake up the remote computer by sending appropriately
configured WOL signal. If the remote computer was shut down in a state capable of
receiving WOL signal, it will wake up and report to the Gateway and a connection will be
established.

& Explicit Wake-on-LAN: A network administrator, using either PROXY Pro Master or
PROXY Pro Gateway Administrator, can attempt to wake up a remote computer by
explicitly sending the WOL signal to that machine. If the remote computer was shut down
in a state capable of receiving WOL signal, it will wake up and report to the Gateway and
a connection will be established.

See "Send Wake-on-LAN Signal" in the Proxy Pro Master Guide for more information.

Peer-to-peer connections

When a computer with PROXY Pro Master establishes a direct connection to a computer
with PROXY Pro Host, the connection that is established is a peer-to-peer connection.

By default, PROXY Pro Master searches the network for Host computers when it starts
up. Any Host computers it finds are listed on the Peer-to-Peer Hosts tab of the PROXY
Pro Master window.

17
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Peer-to-peer connections from Master (M) to Host (H)

The dotted and solid lines, shown in above depict two different sets of peer-to-peer
connections between PROXY Pro Masters to PROXY Pro Hosts. PROXY Pro’s peer-to-
peer connections enable the following:

& PROXY Pro Master users with proper credentials can securely access Host
computers within the network.

4 When you permit full access to a Host computer, the PROXY Pro Master user can
monitor all activity on the Host computer. In addition, PROXY Pro Master users with full
access rights can exercise complete control over that computer.

¢ When the Host and Masters are in the same domain, PROXY Pro Host can be
configured to use the Microsoft Windows authentication service to check credentials of
any PROXY Pro Master users. An access control policy can allow (or deny) full or partial
access for authenticated PROXY Pro Master users to access services on a Host
computer.

Although PROXY Pro’s peer-to-peer connections provide a secure solution for remote
support, this solution is not recommended for large and/or highly distributed networks;
instead, consider using PROXY Pro Gateway for centrally managed remote support
connections.
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Gateway-managed connections

When a computer with PROXY Pro Master establishes a connection to a computer with
PROXY Pro Host through a central server (i.e. PROXY Pro Gateway), the connection
that is established is a Gateway-managed connection. In this way, the Gateway serves
as a central location for managing and monitoring connections, configuration, security
and reporting. Any Host computers found by the Gateway are listed on the Gateway Hosts
tab of the PROXY Pro Master window.

In large networks, the PROXY Pro Gateway can be configured to manage connections
with hundreds or thousands of Hosts simultaneously, enabling Masters to find and take
control of Hosts instantly.

Gateway-managed connections utilize the same strong authentication and authorization
that is available with PROXY Pro’s peer-to-peer connections. In addition, PROXY Pro
Gateway provides the following capabilities:

€ Seamless connections from Master computers to Host computers through a PROXY
Pro Gateway. To the PROXY Pro Master user, the connection appears as if it were a
peer-to-peer connection to the Host computer, even if the Host is outside the domain
and/or behind a firewall or NAT device.

4 Centralized management of access rights to remote computers in your network. Once
you configure your Host computers to report to the PROXY Pro Gateway, you can
achieve global management through a single security policy that you configure using
PROXY Pro Gateway Administrator.

€ User-based access policies. Customize and apply access policies to individual
PROXY Pro Master users or groups in your network. Allow full remote access to one or
more Host computers for some PROXY Pro Master users, while restricting access rights
for others.

& Comprehensive logging and auditing of all remote control activity within your network.
With this feature, you can keep records of all remote support connections.

4 Continuous screen recording. PROXY Pro Gateway allows you to record screen
activity on any remote Host. Efficient file compression makes 24x7 recording economical
and manageable.
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Gateway (G)-managed connections from Master (M) to Host (H)

Firewall-friendly connections

When PROXY Pro Master users need access to Hosts that are outside the domain,
and/or behind a firewall or NAT-device, normal peer-to-peer or Gateway-managed
connections will not work. In these cases, it is difficult to find and maintain a secure
remote support connection because of dynamic port assignments and other network
challenges.

For these situations, PROXY Pro Gateway builds special firewall-friendly connections to
these Hosts. When Hosts are outside the domain, the Hosts are programmed to
automatically initiate contact with the Gateway. The Gateway will use this initial contact to
build a firewall-friendly connection to the Host. In this way, the remote Host outside the
domain will appear just like any Host inside the domain.

Terminal services connections

PROXY Pro provides server-side support (screen capture, input control, screen
recording) for session-based virtual desktops hosted by Terminal Services on Windows
Server 2003 or Window Server 2008 (now called "Remote Desktop Services"). Windows
Server creates and hosts the Terminal Services (TS) sessions like virtual machines. A
presentation technology using a display protocol such as RDP from Microsoft or ICA from
Citrix is typically used to remote the session display, as well as the keyboard and mouse
input, to and from an end user device (such as a thin client computer like a Wyse
terminal).

PROXY Pro allows technicians to capture (and if desired, record) the session
presentation information at the Windows Server before it is remoted to the end user
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device over the RDP or ICA display protocol. PROXY Pro is able to do this by injecting a
Host instance into each server-side TS session, which in turn captures and sends
presentation information directly to PROXY Pro Gateway for recording and/or further
transmission to a PROXY Pro Master.

Note: Because TS sessions are captured at the Windows Server (and not at the end user
device), PROXY Pro Host effectively bypasses the technology used to remote the
sessions to the end users, and will therefore be compatible with Microsoft Terminal
Services clients as well as Citrix Presentation Server (now known as XenApp) clients.

Note: PROXY Pro only supports TS sessions created on server-class Windows operating
systems such as Windows Server 2003 and Windows Server 2008.

See Terminal Services tab in PROXY Pro Host Guide for more specific configuration
and setup information.

Root Host for TS sessions

The “Terminal Services” feature of Windows Server 2003 and Windows Server 2008
allows multiple virtual desktop sessions to be active simultaneously. PROXY Pro
provides remote access and remote control to these sessions on the Windows Server by
injecting a separate instance of the Host service into every new TS session. A special
version of the Host called the "root" Host must be loaded on the TS server (a "root" Host
is a standard Host with a special TS license key - see About tab in the PROXY Pro Host
Guide for more information); it will automatically spawn new Host instances every time a
new TS session is created.

Transient Hosts

Each TS instance of the Host will have its own unique workstationID and must be
configured to report to a Gateway. When it first reports to the Gateway Server, it will be
automatically managed and added to the “All Hosts” group. The TS Hosts are considered
transient, since they go away when the TS user logs out of his/her session. In order to
keep track of transient TS Hosts, the PROXY Pro Gateway will create a new Group
called "Terminal Services on <Servername>", and automatically insert transient Hosts
into this Group. They are automatically deleted from the Gateway when the TS session
ends. The main purpose of this Group is to allow security to be assigned to the Hosts and
TS sessions that belong to this Group, and to provide the correct and appropriate access
to the TS-based Host instances.

Note: PROXY Pro Host for Terminal Services works on Server 2003 & Server 2008, and
requires a Gateway Server v6.10 or later.

Recording TS Hosts

Recordings are normally deleted from the Gateway database when their associated
workstation record is deleted. Transient TS Host workstation records are automatically
deleted from the Gateway when the TS user logs out of his/her session. However, to
prevent recordings of TS Hosts from being automatically deleted when the TS session
ends, the TS session recordings are reassigned to an artificial permanent workstation
record called "Recordings on <Servername>". All recordings of all TS Hosts on a given
TS server will be associated with this one record. This approach has the following
advantages:

€ Recordings are not orphaned
@ All recordings can be kept in one place,

€ TS recordings can be kept separate from console (root Host) recordings
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€ Security can be configured separately for each recording.

Limitations of TS Hosts

Due to technical limitations and the nature of Terminal Services sessions, the following
Host features are not supported.

€ Remote printing
& Keyboard and mouse suppression (requires kernel-based input stack intercept)
€ Screen blanking (requires kernel-based support and physical display to blank)

& Peer-to-peer connections: all protocols are disabled, and the only connections that
can be made are through a configured Gateway Server

€ Kernel-mode screen capture (even on Windows Server 2003, requires kernel-mode
display support)

VNC connections

PROXY Pro provides remote access and remote control to computers running a standard
version of VNC (Virtual Network Computing) server. A VNC server is built into recent
versions of the Mac OS X operating system from Apple Computer, and is also available
on many versions of the Linux operating system. When properly configured, technicians
can use PROXY Pro Master on Windows to connect to and take control of Mac and Linux
computers running standard VNC server.

PROXY Pro currently supports peer-to-peer connections to VNC servers. Support for
Gateway-managed connections to VNC servers is expected in the next release.

See "VNC Hosts" in the PROXY Pro Master Guide for more information on configuring
and connecting to VNC servers.

Supported Platforms

PROXY Pro Master can interoperate with standard VNC servers on following platforms:
4 Mac OS X v10.5 “Leopard”

¢ Mac OS X v10.6 “Snow Leopard”

4 Red Hat Linux Fedora 11
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PROXY Pro security features

One of the most valuable aspects of PROXY Pro remote desktop solutions is the ability to
create and enforce fine-grained access control policies, and to easily modify them to
reflect changes in your organization.

PROXY Pro security features include the following:
¢ “Authentication”

¢ “Authorization”
¢ “Auditing”
*

“Encryption”

Authentication

In the PROXY Pro model, PROXY Pro applications that request information and services
are considered “clients” and those that provide information and services are considered
“servers”. For example, the PROXY Pro Master is considered a client when it connects to
and requests a list of Hosts from a PROXY Pro Gateway. In turn, the PROXY Pro
Gateway is considered a client when it connects to and requests information from a
PROXY Pro Host in the same domain.

Connection Client Server

Peer-to-peer Master Host

Gateway-managed (Gateway & Host are in same domain)

¢ Master-
Gateway Master Gateway

relationship

¢ Gateway-
Host Gateway Host

relationship

Gateway-managed (Gateway & Host are not in same domain)

¢ Master-
Gateway Master Gateway

relationship

¢ Gateway-
Host Host Gateway

relationship

When PROXY Pro Host is not in the same domain as the Gateway, the relationship is
automatically reversed: The Host is programmed to be the client and will reach out to the
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Gateway (see “Firewall-friendly connections” for more information about PROXY Pro
firewall-friendly connections).

To guarantee security in the PROXY Pro environment, it is critical that PROXY Pro
components acting as servers validate the credentials of users of PROXY Pro
components acting as clients before they provide access or data. The burden is placed
on the client to authenticate itself to the server. PROXY Pro implements two types of
authentication to support this:

€ ‘“ldentity Authentication”
€ “Endpoint Authentication”

Identity Authentication

In general, this operation answers the following security question: How does the server
know who the client is? A PROXY Pro application acting as a server will not provide
access or information to any PROXY Pro application acting as a client until it can validate
that client’s identity. PROXY Pro provides the server three different methods of
authenticating the identity of the PROXY Pro client:

c . Windows Simple Shared-
onnection S secret

authentication password

password

Peer-to-peer Yes Yes No
Gateway-managed (Gateway & Host are in same domain)
¢ Master-
Gateway Yes No No
relationship
¢ Gateway-
Host Yes No Yes
relationship
Gateway-managed (Gateway & Host are not in same domain)
¢ Master-
Gateway Yes No No
relationship
¢ Gateway-
Host No No Yes
relationship

€ Windows authentication: By default, a PROXY Pro application acting as a server
uses Windows authentication to check the Windows credentials of the client application:

+ The Host will check the Windows credentials of the PROXY Pro Master user in
the case of a peer-to-peer connection;
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+ The Gateway will check the Windows credentials of the PROXY Pro Master users
in the Master-Gateway part of a Gateway-managed connection;

+ The Host will check the Windows credentials of the user logged into the Gateway
in the Gateway-Host part of a Gateway-managed connection (when Host and
Gateway are in the same domain).

NOTE: If Host and Gateway are not in the same domain, Windows authentication will not
usually be available. In that case, Host and Gateway will rely on Shared secret password.

€ Simple password: Prior to making a connection, a custom password can be created
on the Security tab of the Host and shared with PROXY Pro Master user. This feature
permits the PROXY Pro Master user to connect to a Host without regard to PROXY Pro
Master user’s Windows credentials.

NOTE: Simple password applies only to peer-to-peer connections.

€ Shared secret password: In the case that the Host does not share a domain
relationship with the PROXY Pro Gateway, or if the Host is outside of the network and
cannot contact its domain controller, Windows authentication will not usually be available.
Behind the scenes, the PROXY Pro Gateway and the Host will exchange a 16-byte
secret password that only they will know. As a result, in all subsequent connections, the
PROXY Pro Gateway and Host will have some measure of authentication when they are
not in the same domain. If the Host belongs to the same domain as the PROXY Pro
Gateway, and the Host is able to reach a domain controller, the Host will prefer to do
Windows authentication instead of shared secret password.

Endpoint Authentication

In general, this operation answers the following security question: How does the client
know it is connected to the right server? Identity authentication doesn't prohibit the client
from being fooled into connecting to a different server. In order to guarantee that
information and services are coming from the expected server, PROXY Pro supports
endpoint authentication using Secure Sockets Layer (SSL).

& SSL certificate authentication (PROXY Pro Gateway only): PROXY Pro has
implemented server endpoint authentication using SSL, which means the client will
request and validate a certificate from the server before providing requested information
or services. This ensures the client has connected to the right server. The following list
describes where SSL authentication can and cannot be used:

+ Peer-to-peer connections: SSL authentication is not available for peer-to-peer
connections. This would require each Host (acting as server) to carry its own
certificate, which would be unwieldy and costly to manage.

+ Gateway-managed connections (Host is in same domain as Gateway): SSL
authentication is available between Master (acting as client) and Gateway (acting as
server). Before connecting, the Master will request and validate a certificate from the
Gateway. In general, SSL between Master and Gateway would be most useful when
the Master is outside the LAN and/or coming in through a corporate firewall to access
the Gateway.

NOTE: SSL authentication is not available between the Gateway (acting as client) and the
Host (acting as server). As in peer-to-peer connections, this would require each Host to carry
its own certificate. SSL connections to the Host are generally not required because the Host
can be configured to use a reverse connection to the Gateway, which can use SSL.

+ Gateway-managed connections (Host is not in same domain as Gateway):
When the Host is outside the LAN and/or behind a firewall or NAT-device, the Host is
the client and has responsibility to contact the Gateway. SSL authentication is
supported and would be appropriate to ensure that the Host is connecting to the right
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Gateway. The Host will validate the Gateway Server certificate before accepting the
connection, ensuring that the Host is communicating with the correct Gateway Server.

In summary, SSL can be used by the Master to authenticate a Gateway, and by a Host to
authenticate a Gateway when the Host is outside the domain:

Connection Client Server gigported
Peer-to-peer Master Host No
Gateway-managed (Master & Host are in same domain)

¢ Master-Gateway Master Gateway Yes
relationship

# Gateway-Host Gateway Host No
relationship

Gateway-managed (Master & Host are not in same domain)

¢ Master-Gateway Master Gateway Yes
relationship

# Gateway-Host Host Gateway Yes
relationship

Authorization

One of the strongest features of PROXY Pro remote support solutions is the fine-grained
access control. For example, to perform remote support, you must have the following:

@ Proper credentials with which to connect to the Host computer
& Authorization to view the Host computer remotely
4 Authorization to control the Host computer remotely

Your credentials are established when you connect to a Host computer (or to a PROXY
Pro Gateway), and persist until the connection breaks. You can configure access and
other rights directly on the Host computer for peer-to-peer connections. Alternatively, you
can use the PROXY Pro Gateway to enforce custom access rights policies on PROXY
Pro Master users, roles, or groups for Gateway-managed connections.

Auditing

PROXY Pro Gateway provides a detailed log of connection attempts, actions and other
activities that occur in the network. This log is also customizable and exportable to 3rd
party reporting products using standard formats.
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PROXY Pro Gateway also features screen recording for any Host in contact with a
Gateway, whether or not there is an active remote support connection. With this feature,
PROXY Pro Master users can keep a visual log of activities going on in the network.

Encryption

To ensure privacy of communications between PROXY Pro applications across the
network, PROXY Pro provides advanced encryption using Advanced Encryption
Standard (AES) block ciphers and Secure Hashing Algorithm (SHA-1). This protection
will be automatic and transparent every time two PROXY Pro 5.20 components or later
are communicating with each other.

By default, PROXY Pro Workstation Edition and PROXY Pro Gateway Edition uses AES
256-bit encryption, however other encryption options can be set, including:

& AES encryption (256-bit key) with SHA1 hash

€ AES encryption (192-bit key) with SHA1 hash

€ AES encryption (128-bit key) with SHA1 hash

& Triple-DES (3DES) encryption (192-bit key) with SHAL hash
€ RC4-compatible encryption (128-bit key) with MD5 hash

NOTE: PROXY Pro 5.10 applications and older support only RC4 encryption; thus, this would be
the encryption option negotiated between a PROXY Pro 5.20 or later application (e.g. PROXY Pro
Master) and PROXY Pro 5.10 application (e.g. PROXY Pro Host).

Order of precedence

When two PROXY Pro components have different encryption options set, the first
encryption choice in common between the two is used (going down the list in order), with
preference set as follows:

& Preference set by the Host, when the Gateway requests connection to the Host

& Preference set by the Gateway, when the Master requests connection to a Host
through the Gateway
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PROXY Pro networking features

PROXY Pro remote desktop solutions support several standard transport protocols for
computer-to-computer communication, and two types of network addressing schemas.

Network protocols

PROXY Pro products support most of the standard networking and transport protocols,
including:

@ |P: IP is a general-purpose protocol supported on a wide variety of networks and
servers. PROXY Pro components support communications using either the TCP or UDP
transport protocols running over IP. PROXY Pro has established the following standard
ports for use with either TCP or UDP:

+ PROXY Pro Host listens on port 1505 by default
+ PROXY Pro Gateway listens on port 2303 by default

& |IPX: IPX provides access to Novell NetWare servers. PROXY Pro components
support communications using this protocol.

€ SSL: The SSL protocol runs above TCP/IP and below higher-level protocols such as
HTTP or IMAP. Using TCP/IP on behalf of the higher-level protocols allows an SSL-
enabled server to authenticate itself to an SSL-enabled client, and then establish an
encrypted connection between the remote computers.

+ By default, PROXY Pro Gateway listens for incoming SSL connections on port 443,
but it might be appropriate to note that this can be easily changed to avoid conflicts
with other server software installed on the same machine.

+ The PROXY Pro Gateway now ships with a Gateway Certificate Manager to
manage the creation and/or selection of a SSL security certificate for the PROXY Pro
Gateway.

Network addressing schemas

The PROXY Pro UDP, TCP and SSL transport protocols support the use of either IPv4
(32-bit) or IPv6 (128-bit) addresses.
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PROXY Pro documentation and technical support

Each of the four PROXY Pro components has its own guide:
¢ PROXY Pro Master Guide

¢ PROXY Pro Host Guide

¢ PROXY Pro Gateway Administrator Guide

¢ PROXY Pro Deployment Tool Guide

For more information about PROXY Pro documentation and technical support, see:
& "Typographical conventions"

€ "Technical support options"

Typographical conventions in documentation

PROXY Pro documentation uses typographical conventions to convey different types of
information.

Computer text

Filenames, directory hames, account names, IP addresses, URLs, commands, and file
listings appear in a plain fixed-width font:

You can use the default domain user account named ‘RemoteControlGateway’.

In examples, text that you type literally is shown in a bold font.
To run the installation program, type installme in the command line.

Screen interaction
Text related to the user interface appears in bold sans serif type.
Enter your username in the Login field and click OK.

Menu commands are presented as the name of the menu, followed by the > sign and the
name of the command. If a menu item opens a submenu, the complete menu path is
given.

Choose Edit > Cut.
Choose Edit > Paste As... > Text.

Variable text

Variable text that you must replace with your own information appears in a fixed-width
font in italics. For example, you would enter your name and password in place of
YourName and YourPassword in the following interaction.

Enter your name: YourName
Password: YourPassword
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File names and computer text can also be displayed in italics to indicate that you should
replace the values shown with values appropriate for your enterprise.

Key names

Names of keyboard keys appear in SMALL CAPS. When you need to press two or more
keys simultaneously, the key names are joined by a + sign:

Press RETURN.

Press CTRL+ALT+DEL.

Technical support options

If you have any problems installing or using the PROXY Pro remote support products,
information and support resources are available to help:

This manual and the Release Notes may contain the information you need to solve
your problem. Please re-read the relevant sections. You may find a solution you
overlooked.

Our technical support staff can be contacted by the following means:

€ Web: Fill out a support request at http://www.proxynetworks.com/support
and a case number will be automatically assigned to you

€ Phone: (617) 453-2710
€ Email: support@proxynetworks.com.

We offer a range of support options including support and maintenance contracts, and
time and materials projects. Consult our web site for the support plan that best meets

your needs. Goto http://www.proxynetworks.com and navigate to the Support
section of the web site for more information.
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The Deployment Tool can be installed with the following considerations:
€ '"System requirements"
€ "Microsoft Management Console requirements"

€ 'Target computer requirements”

Installation notes

The Deployment Tool is distributed as part of the Workstation Edition or Gateway Edition
bundles. Unzip the contents (while preserving the directory tree structure) on your
computer.

Click on the DeploymentTool.msi file to install the product.
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Licensing

The Deployment Tool does not require a license.
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System requirements

The Deployment Tool can be installed on any computer that runs a supported operating
system (OS) and matches the requirements described in this section.

Operating System Requirements
Supported operating systems are:

4 Windows XP

4 Windows Server 2003

4 Windows Vista

4 Windows Server 2008

¢ Windows 7

4 Windows Server 2008 R2

The Deployment Tool is supported on both 32- and 64-bit editions of these operating
systems (except Windows Server 2008 R2, which only comes in 64-bit edition).

Hardware Requirements
The hardware requirements are:

€ Minimum requirements — Same as those specified by Microsoft for the respective
operating system.

¢ Recommended requirements — Same as those specified by Microsoft for the
respective operating system.

Installation Requirements

The following additional requirements are required or recommended for installation of
Deployment Tool:

€ Windows Installer 2.0 or later — Required by the installer. If needed, this upgrade is
applied automatically when the setup.exe installer image is run.

@ Internet Explorer 4.0 or later — Required for online help.
€ Microsoft Management Console 3.0 is recommended

& Local Administrator access rights — Required for the user who is installing Deployment
Tool on the machine.

& Microsoft Core XML Services (MSXML) 6.0 — Required. If the Deployment Tool cannot
find the redistributable MSXML6 system component, an error message will appear and
the navigation tree will be restricted to the single root node. In this case, you must install
MSXML6 and restart the Deployment Tool. See http://www.microsoft.com for more
information about the redistributable msxml6.msi package.

NOTE: These prerequisites are met by the supported platforms, and therefore they are not
included in the software distribution packages.
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Operating Requirements
The following requirements are recommended for operation of Deployment Tool:

€ Domain Administrator access rights - Because the Deployment Tool accesses other
computers on the network, the tool should be operated with domain administrator
credentials. This provides the access rights to manage all of the computers within the
domain. If the Deployment Tool is run from an account that does not have access rights
to a computer in your network, a password prompt will appear.
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Microsoft Management Console requirements

The Deployment Tool uses the Microsoft Management Console (MMC).

The Deployment Tool stores state information, such as the list of paths to the installation
files, product configurations, the network places hierarchy, and the reports, via MMC.

NOTE: In MMC v2.0, different users of the console file do not share state data. State
information is preserved if the Deployment Tool is uninstalled and later reinstalled.

Adding the Deployment Tool to the MMC

The Deployment Tool can be added to other console files in MMC by selecting File >
Add/Remove Snap-in from the MMC menu bar. On the Standalone page of the
Add/Remove Snap-in dialog that appears, follow these steps:

1 Click Add and select the Deployment Tool from the list that appears.
2 Click Add and then Close.

3 Click OK to close the remaining dialog and complete the process.
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Target computer requirements

The Deployment Tool can be used to install or uninstall software (usually the Host) on
target computers that meet the following requirements:

€ Windows Management Instrumentation (WMI) must be installed and the service must
be running. This is installed by default for Windows XP and later platforms.

¢ WMI Windows Installer Provider must be installed. For Windows Server 2003, you
must explicitly select this optional component. See "WMI Windows Installer Provider
installation" below.

€ Microsoft Windows Networking must be installed and enabled

€ Remote Procedure Call (RPC) must be enabled on target computers (i.e. standard
administrative shares TPC$ and ADMINS must be accessible).

€ Your target computers must support authentication of remote users. Under Windows
XP Professional on computers that are not members of the domain, there is a local
security policy that may prevent this. See “Sharing and security requirements for
Windows XP” below for more information. Windows XP Home does not support
authentication of remote users and therefore is not supported as a target operating
system.

Sharing and security requirements for Windows XP

Follow this procedure to set up a sharing and security policy for local accounts, which is
required for Windows XP:

1 Select Control Panel > Administrative Tools > Local Security Policy.

2 Under Security Settings > Local Policies > Security Options > Network access: Sharing
and security model for local accounts, set the value to Classic - local users authenticate as
themselves.

WMI Windows Installer Provider installation

To install the WMI Windows Installer Provider for Windows Server 2003, follow these
steps:

Double-click Add/Remove Programs in the Control Panel.

Select Add/Remove Windows Components from the left-hand column.
Select Management & Monitoring Services in the list.

Click Details.

Check WMI Windows Installer Provider.

Click OK.
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Click Next to complete the installation.
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After installing the Deployment Tool, start it from the Windows Start menu and the
Deployment Tool window appears:

J-;; Deployment Tool =]
B5 Fle Action Yiew ‘Window Help |;|i|5|

© = |m| 2’

: (] Installation Files

D Product Configurations we I come to th e

+- % Metwork Places

é Ecttive Di:ectory Dornains De p I ovm €n t TOOI

-] Reparts
This utility allows you to configure the installation of
PROXY Pro software, and to install the software on
remote machines. There are three simple steps to
deploying PROXY Pro software:

(1) Inform the Deployment Tool where the product
installation image (i.e. HOsT.M51) you wish to use is.
Because the Deployment Tool is not tied to a specific
release of PROXY Pro, you must have a copy of the
version of PROXY Pro you wish to deploy either on the
local computer, or on a network share.

» Click here to add an installer image to the
"Installation Files" collection.

(2) Create a product configuration, customizing the
PROXY Pro Host or PROXY Pro Master settings =

all o

|Done | |

The Deployment Tool has five main options, which are represented in the left-hand side
navigation window:

@ ‘“Installation Files”, for loading the Host, the Gateway, or the Master installer files to
distribute via the Deployment Tool

@ “Product Configurations”, for creating Windows Installer Transform .mst files with

custom configuration changes that you wish to push out to remote computers via the
Deployment Tool

& “Network Places”, for specifying target computers within your network on which to
install or uninstall software on (as well as to remotely rebooting any network computer)
using NetBIOS commands

@ “Active Directory Domains”, for discovering remote computers and OUs in your
domain, and for installing new software or upgrading older versions of existing software

@ “Reports”, for viewing results of product deployment activities via the Deployment Tool

37



PROXY Pro Deployment Tool Guide

The general process for loading and distributing software via the Deployment Tool is
described in the results pane:

There are five simple steps to deploying software:

1 Inform the Deployment Tool where the product installation image (i.e. HOST .MSI) you
wish to use is. Because the Deployment Tool is not tied to a specific release, you must
have a copy of the version of Host or Master you wish to deploy either on the local
computer, or on a network share.

2 Create a product configuration, customizing the Host or Master settings according to
your environment. All of the Host settings are configurable at install time; in addition,
installation-time information like User Name, Organization, and License Key can be
specified as well.

3a Scan the network for domains and workgroups, then scan a domain or workgroup for
computers. This allows the Deployment Tool to remember information about each
computer that it gets details on, including what version of software is installed on that
computer, and whether we have access to deploy software to it. Note that unlike the
Windows Explorer, the Deployment Tool does not automatically refresh the "Network
Places" collection; you need to manually refresh this list.

_or-

3b Use Active Directory to locate domains, organizational units and computers. This
allows the Deployment Tool to remember information about each computer that it gets
details on, including what version of software is installed on that computer, and whether
we have access to deploy software to it. As with "Network Places", the Deployment Tool
does not automatically refresh the "Active Directory" collection; you need to manually
refresh this list.

4 Having completed step 3a or 3b, you're almost ready to deploy software. Right-click
on a domain or workgroup name under Network Places, and pick Refresh Computer
List, in order to enumerate the computers in the domain or workgroup. Or right-click on a
domain under Active Directory and pick Refresh Organizational Units and
Computers to enumerate the domain. Select the domain, workgroup, or org unit, select
one or more computers in the list in the result pane, then right-click and pick Install
Software... to begin the software deployment process.

5 The results of each Deployment Tool task will be available in a report under the
Reports node.

NOTE: If the Deployment Tool cannot find the redistributable MSXML6 system
component, an error message will appear and the navigation tree will be restricted to the
single root node. In this case, you must install MSXML6 and restart the Deployment Tool.
See http://www.microsoft.com for more information about the redistributable msxml6.msi
package.
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Product Configurations

If you would like to change any configuration settings in the Installer files before you
distribute them, the next step of the software deployment process is to create and load a
Windows Installer Transform file with the custom settings you desire.

In order to create a Windows Installer Transform file, you must first create and/or edit a
Product Configuration file containing the configuration changes you wish to make for a
particular Installer file. Then you must apply these changes to a Installer file to create the
Transform file.

Creating a new Product Configuration file

Every new Product Configuration file created in the Deployment Tool initially has all
configuration options set to default values.

To create a configuration for the Host, Master or Gateway with default configuration
options, follow these steps:

1 Right-click on the Product (Host, Master or Gateway) listed under Product Configurations
for which you intend to create a default configuration.

2 Select New Configuration.

3 Enter a name for the configuration and click OK.
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Mew Product Configuration Properties [ 7] |

General |

Praduct Marne: I Host j

Configuration Mane: Ichst_tesﬂ

k. I Cancel Help

A new node for this named configuration appears in the left-hand navigation tree under
the Product that you selected.
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E5 Fle Action View Window Help |;|i|5|
- |G| E R 2
@ Deployment Tool
7.7 Installation Files
=] [Z3 Product Configurations Name # | Vvalue | Class "
-1 Gateway % "add or Remove Programs”... Installation
D Host @ Access Restriction Addresses Protocal
: 8 Hast_test @ Access Restriction Made Protacal
B2 Master -
& Network Places @ .D.I:u:es.s Restrictions .Dt-:u:ess
é active Directary Daomains @ Add License License
[:l Reports & Administration Password Security
G Administration Password R, Security b
@ Administration Security Security
@ Allow Contral Panel Access Access
@ Allow Remote Administr akion Security
% EBeep on connect/disconnect General
% Beep while connected? General
@ Connection Password Security
@ Connection Permissions Access
% Enable IPX Protocal Protocal
% Enable TCP Protocol Protocal
§ Enable UDF/IP Protocal Protocal
@ Encrypk Connection Protocol
-
J -l
Extended A Standard /

Changing Configuration Settings in the Product Configuration
file
Initially, the Product Configuration file starts off with all default values. To modify one or

more of these, double click on the setting in the result pane and select the desired setting
in the resulting popup window.

1 Select the configuration to modify. All configurations parameters are listed on the
right-hand side of the Deployment Tool.

2 Double-click the configuration parameter you want to modify. When a properties
dialog appears, select any options you want. If you select Use current value or installation
default, then the parameter is assigned according to the following:

@ If an existing installation with a configured value for this parameter already exists (for
upgrades), the existing installation parameter value is retained.

€ The default installation configuration options for the selected parameter are used
either when an existing installation does not yet have a value for this parameter or for
new installations.

3 Click OK when you are done.

Once you apply the change, the new setting will be reflected in the result pane of the
Product Configuration file.
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For more information about specific configuration settings for the Host, Master or
Gateway, see:

& “Configuration options for the Host”
& “Configuration options for the Master”

€ “Configuration options for the Gateway”

Creating Windows Installer Transform file
You are now ready to create a Windows Installer Transform file:

1 Right-click on a Product Configuration file in the navigation tree and select New >
Transform File.

2 In the first dropdown box, find the original Installer (.msi) file corresponding to the type
of Product Configuration file you selected in the left-hand navigation box (this should
have been loaded in the first step of this process (see "Installation Files").

3 Input a filename for the new Windows Installer Transform file and click OK to create
new Windows Installer Transform file.

Create Installation Transform Properties EH |

Create |

|nztallation File Mame:

IHl:usI: msi j

Transfarm File Mame:

[Host_Modiied _|

Configuration M arme:

I Hozt_test j

k. I Cancel Help

The new Windows Installer Transform file will appear in the left-hand navigation under
Installation File. Note that configuration settings that have been changed will show new
setting in the Value column and Default flag will be set to "No".
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#% Deployment Tool H[=] E3
@ File Action ‘“iew ‘Window Help | o = |
o (X B2
@ Leployment: Tool -Iinzl C:\Documents and Settings\Administrator\DesktopProxy-v7-0-0-1506-GatewayEdition |
=2 Installation Files
e Host.msi
@l Host odified. ST Hare | vslue | Defat | Class |
=2 Product onFigurations & Show icon while idie? Yes General
b Gateway [0 receate Transform File § Station Name es General
E|[:| Host & "add or Remove Pro... Yes Installati
. fE} Host _test & Installation Directory Yes Tniskallati
E‘D MMasker @ License Yes Installati
-4 Metwork Places & Organization Yes Installati
- Active Directory Domains @ Restart After Install... Yes Installati
(-] Reports & User Mame Yes Installati
@ Add License Yes License
':@:' Blank Screen always Mo Qpkions
@ Lock workstation ©n... Yes Options
@ Logout Cn Disconneck Yes Jptions
@ Reboot On Disconneck Yes Jptions
@ Suppress Keys Yes Oplions
@ Access Restriction &, Yes Pratocal
@ Access Restrickion M... Yes Protocal
% Enable IPX Protocol Yes Prataocal
% Enable TCP Protocol Yes Protocal
& Enable UDP{IP Protocol Yes Protaocal
-
Frrvunt Cannackinn o Drnbreal
R 2 d | 3
|D|:|ne | |

You can now proceed to either Network Places or Active Directory Domains to select
target computers and deploy either the original Installer file or the new Windows Installer
Transform file.

Configuration options for the Host

Most of the configuration options in the Host Control Panel window can be modified.
These options are related to the PHSetup commands that you execute from a command
line. For more information, see the Host Guide.

Modify the following configuration options for Host:

Access tab
€ Access Restrictions: Specify the remote access policy:

+ Select Permit connection to permit remote connections from authenticated
Master users to your Host computer.

+ Select Lock out connection to prevent any remote connections from Master
users to your Host computer.

+ Select Lock out or Permit connection based on time zone to permit or refuse
remote connections to your Host computer based on the day of the week and the
time of day. You can specify permitted access by time when you click Time Zone
Settings.

€ Time Zone: Specify the period for remote access.
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€ Connection Permissions: You can optionally specify that you require or allow the Host
computer operator to grant remote access permission to the Host computer. If you
require this feature, you can change the Grant Permission Time. If you allow for this
feature, you change the Request Permission Time.

+ Select No permission required (default) to allow remote connection to your Host
computer from anyone who satisfies restrictions you specify as authentication
security settings.

+ Select Permission must be granted by Host if you want to know when a remote
user attempts a connection. From the Host’s user must respond within list, select
the time within which you must accept or reject a request. When a remote
connection is requested, the Request Permission for Connection window
appears. You can accept or reject the request. If you do not respond within the
specified time, the request is rejected automatically.

+ Select Permission requested from Host if you want to know when a remote user
attempts a connection. From the connection continues after list, select the time
after which the connection will be made. When a remote connection is requested,
the Request Permission for Connection window appears. You can accept or
reject the request. If you do not respond within the specified time, the request is
accepted automatically.

+ Select Lock workstation if permission not explicitly granted if you want the
Host to lock the workstation prior to beginning a new remote control connection
(if user is bypassing Host permission). This prevents the new user from
"hijacking" the logged-in user's session unless he/she knows the credentials to
unlock it.

€ Grant Permission Time: Specify the period before the time-out when you require the
Host computer operator to grant remote access permission to the Host computer.

€ Request Permission Time: Specify the period before the time-out when you allow the
Host computer operator to grant remote access permission to the Host computer.

@ Allow Control Panel Access: Allow or deny access to the Host control panel directly on
the Host computer.

€ Lock Workstation on Default: If "Yes", the workstation is locked if the "Permission to
connect” dialog times out. The workstation is not locked if the console user responds to
the dialog. If "No", the workstation is never locked.

Effects tab
€ Manage Visual Effects: Specify the how visual effects features are remotely controlled.

& Effects: Sets the flags for the management of visual effects. Checking a box for a
category causes that category of effects to be disabled during a connection.

General tab

4 Station Name: Modify the name by which your Host computer identifies itself to
Gateways or Master users.

Host station name macros are now supported. The Host station name can include strings
in the form %MACRO%, and these macros are substituted at runtime for the correct
values. This complements the SMACRO$ feature in PHSETUP, which provides a one-
time substitution at PHSETUP runtime.

This feature may be useful when creating a Host image for deployment, either using the
Deployment Tool or via imaging of the entire disk. The macro names supported are:
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Macro Description

%NAME% Host computer machine name

%USER% Logged in user at the Host machine

console

Host software version number (e.g.
YVER% “v5.10.2.1003")
%PLATEORM% mfgzoopoe(;%tmg system platform (e.g.
%PROT% Network protocol (e.g. “IP” or “TCP”)
%ADDR% Network address (e.g. “192.168.0.15")
%PORT% Network port (e.g. “1505”)

€ Host Appearance: Configure the Host icon to appear (Icon) or not (Hidden) in your
system tray (lower right corner of your monitor) by selecting either Icon (default) or
Hidden for each of the following:

+ Show icon while idle?: The Host icon appears (or is hidden) when there is no
active remote connection.

+ Show icon while connected?: The Host icon appears (or is hidden) when a
remote connection is active.

€ Beeping: Set auditory cues to indicate when a remote user attempts to connect to your
Host computer.

+ Select Beep on Connect/Disconnect to hear a quick series of three tones rising
in pitch whenever a remote connection succeeds. With this option, you also hear
a series of tones falling in pitch when the remote connection is terminate.

+ Select Beep While Connected Every to hear a short tone periodically,
throughout the duration of any remote connection. You can set the interval
between beeps from 0 to 9999 seconds. If you set this field to 0, then it turns the
beeping off completely.

€ Host Notifications: Sets the flags for enabling/disabling host notification popups.
Checking a box enables that class of notifications. Unchecking a box disables that class
of natifications.

€ Popup notifications: Set visual cues that "popup” on Host screen to indicate when
certain events occur (also called "toast" notifications).

+ Select Enable connect/disconnect notifications to see popup notifications
when a Master user connects or disconnects from the Host.

+ Select Enable file transfer notifications to see popup notifications when a
Master initiates file transfer operations to/from the Host.

Gateways tab

€ Gateways: List the Gateways to which this Host computer reports. These Gateways
must already be deployed in your network.
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€ Require Gateway: Require that all remote connections through this Host computer be
conducted through the listed Gateway or servers.

Installation group

€ "Add or Remove Programs" list in Control Panel: Setting this value to "disable" will
disable the ability to Add/Remove/Modify the product via the system control panel. Do not
set this value to have the product appear in the Add/Remove Programs listing.

# License: Specify your product license here. Note that the Host does not use a “version
upgrade” license, so only one license key is required — your full product or subscription
upgrade key. Keys from previous versions are not accepted by the Host, and should not
be entered.

# Installation Directory: Specify an alternate to the default installation directory.
€ Organization: Allows you to override the default organization with a new value.

€ Restart after Installation: After installing with Deployment Tool, Host reboots only if
necessary. Suppress the automatic reboot without prompting by selecting Use this value
and the Reallysuppress option.

€ User Name: Allows you to override the default username with a new value.

Options tab

€ Keyboard and Mouse Suppression: Control how the keyboard and mouse of your Host
computer behave during remote connection:

+ Select Never suppress the local keyboard and mouse to retain control of the
Host computer’s keyboard and mouse when a remote user connects to the Host.

+ Select Suppress local input, if the Master requests it to give a remote user
control of the Host computer’s keyboard and mouse when the remote user
requests it. The default settings for the Host and the Master allow the mouse and
keyboard to be shared during a connection, with each side able to use both.

+ Select Suppress the local keyboard and mouse at system startup to give full
control of the Host computer’s keyboard and mouse to the remote user who
connects to the Host. This option does not permit mouse or keyboard input on
the Host computer.

€ Action on Disconnect or Termination: Control what happens to the Host computer
when a remote user connection session is terminated, as follows:

+ Select None for the termination of a remote user connection to have no effect
on the Host computer.

+ Select Lock Workstation to lock the Host computer when the remote user
connection is terminated (It can be unlocked or restarted using Windows
commands).

+ Select Reboot Computer, Terminating All Programs to reboot the Host computer
upon the termination of the remote user connection.

Protocols tab

# Protocols: Configure the network protocols. The UDP/IP, TCP/IP, SSL, and IPX check
boxes control the network protocols used for connections to the Host computer from a
remote Gateway or directly from a remote computer.

Use the Port list to select <Standard> or to enter the port number on which the Host
computer should listen for this particular protocol. By default, the Deployment Tool is set
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to have the Host computer listen on UDP port 1505 and TCP port 1505. These are the
standard ports, so you do not need to specify them.

You can choose your encryption option under Select Cipher list in Encryption Connection:

Preferred Ciphers Properties E |

Preferred Ciphers |

£ Use current walue or installation defaulk prefierredtiphiers

* Use this value

Current preferred cipher lisk:

Sets the lisk of encrypkion ciphers that the Host will use in order of ;l
decreasing preference.

Ok, Cancel apply | Help |

€ Access Restriction Addresses: Sets the TCP/IP restricted addresses

€ Access Restriction Mode: Sets "Grant" or "Deny" access to the Host based on TCP/IP
addresses specified by "tcprestrictions"

Security tab

€ Administration Password: Sets simple password required for administration, if
Windows Authentication isn't used.

€ Administration Password Required: If "same", then the connection password is used
for administration access and any Administration Password setting is ignored. If
"different”, then the Administration Password is used for administration access.

€ Administration Security: Specify Host administrative security settings when you use
Windows security for remote connections.

€ Allow Remote Administration: Specifies whether to allow the settings to be changed by
a remote administrator.

€ Host Settings Security: Specify Host security settings when you use Windows security
for remote connections.
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@ Service Security: Specify service security settings when you use Windows security for
remote connections.

€ Use Windows Authentication: Use Windows security for remote connection
administration.

Screen tab

& Prefer User Mode screen capture: Uses user-mode code to capture screen data.
This is the default option on Windows Vista and Window Server 2008 platforms but can
also be used on Windows XP, Windows 2003 and older platforms if selected.

& Select User Mode Profile: Create your own user mode profile with the following
bandwidth throttling options:

+ Description string: Enter a name for this custom profile

+ Image type: Image type (two choices -- Hextile (default), or JPEG). The Host will
automatically use JPEG compression if the connected Master doesn’t support
Hextile.

+ Color depth/Image quality: Color depth (Hextile)/Image quality (JPEG). When the
image type is Hextile, then the quality value (in the range of 20-100) controls the color
depth reduction feature, with the rule that 24bpp = 100%, 21bpp = 88%, 18bpp =
75%, 15bpp = 63%, 12bpp = 50%, 9bpp =38%, 6bpp = 25%. When the image type is
JPEG, there is no color depth reduction, and the quality value (in the range of 20-100)
controls the JPEG compression level.

+ Polling frequencies (three values -- Capture Rate, Foreground, and Background,
in milliseconds): Specify three values on a scale of 1 to 10, with 1 being the least
aggressive (longest time), and 10 being the most aggressive (shortest time).

+ Bandwidth limit: Specify a numeric value between 5-200 kilobytes/sec, or -1 for
unlimited.

Configuration options for the Master
Modify the following configuration options for the Master:

€ Add/Remove in Control Panel: Set this option to Disable to prevent users from
modifying the Master configuration.

# Installation Directory: Specify an installation directory other than the default.

® License: Specify your product license here. Note that the Master does not use a
“version upgrade” license, so only one license key is required — your full product or
subscription upgrade key. Keys from previous versions are not accepted by the Master,
and should not be entered.

€ Organization: Change the organization name that is shown when you select Help >
About the Master.

€ Restart after Installation: After installing with the Deployment Tool, the Master reboots
only if necessary. If a reboot is required, it occurs without any prompts. You can suppress
the automatic reboot without prompting by selecting Use this value and the
Reallysuppress option.

€ User Name: Change the licensee name from the default (Windows) user name with
this option. This is the registered user name that is displayed when you select Help >
About the Master.
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Configuration options for the Gateway

Modify the following options for the Gateway:

€ Components to install: Install one or both (default) of the following:
+ The server: Gateway (Select Use this value > Server)

+ The administration tool: Gateway Administrator (Select Use this value >
Administration)

€ Gateway server account name: The Gateway server account name is required for new
installations and ignored for upgrades of the Gateway. Type an alternate to the default
domain account used by the Gateway, by selecting Use this value. Configure full security
rights for this domain account in any Host configuration that uses this Gateway to
administer all remote connections.

€ Gateway server account password: Specify the password for the domain account used
for the Gateway. This password is required for new installations and ignored for
upgrades of Gateway.

€ Add/Remove in Control Panel: Set this option to Disable to prevent users from
modifying the Gateway configuration.

# |Installation Directory: Specify a non-default installation directory.

@ License: Specify your product license here. Note that the upgrade process preserves
any previously installed licenses to deployments of Gateway, and none of these licenses
should be deleted on the product.

€ Organization: Change the organization name that is displayed when you right-click
Remote Control Gateway Servers > About.

€ Restart after installation: After installing with the Deployment Tool, the Gateway
reboots only if necessary. If a reboot is required, it occurs without any prompts. You can
suppress the automatic reboot without prompting by selecting Use this value and the
Reallysuppress option.

€ User Name: Change the licensee name from the default (Windows) user name with
this option. This is the registered user name that is displayed when you right-click Remote
Control Gateway Servers > About.
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Network Places

Once you have loaded your Installer file(s) and/or your Windows Installer Transform
file(s), you can go to Network Places to specify the list of target computers for
deployment. Network Places uses NetBIOS to discover and provide access to remote
computers in your domain or workgroup.

Once you select the target computers, you can use the Deployment Tool to install,
uninstall the software or push configuration settings.

Add computer

Network Places uses NetBIOS to discover and provide access to remote computers in
your domain or workgroup. If the target computer(s) do not appear, you can explicitly add
a computer to the Deployment Tool navigation tree.

Follow these steps add a target computer:

1 Right-click on the domain or workgroup that contains the target computer. Select the
Add Computer... command:

Refresh Computer Lisk
Add Compuker, ..

&l Tasks 3

Wi k
Mews Window From Here

Delete
Expart Lisk. ..

Help

2 In the dialog box that appears, enter the DNS name of the target computer or the IP
address. If the account you are using doesn't have administrator privileges on the target
computer, you may need to enter the credentials of an account that does.
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Add Computer |

Please enter the name of the computer you wish ko add:

Camputet: I

Cptionally, enter a username and password:

User Mame: I

Passward: I

The target computer will appear under the domain or workgroup in the left pane
navigation tree.

Specify target computers for install or uninstall

To update the list the domains and workgroups, right-click Network Places and select
Refresh Domain/Workgroup List. Information appears in the left and right panes:

& The left pane provides each domain and workgroup name only.

€ The right pane provides the name of each domain and workgroup, along with
additional columns for the number of times it was found, the date it was found, and the
number of computers in it.

To obtain information about the computers in a domain or workgroup, right-click the
domain or workgroup and select Refresh Computer List. Then expand the domain or
workgroup to see the computers in it.
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..'-;3 Deployment Tool _ |O0]
@ Eile  Action  Wiew wWindow Help ‘ 8] =]
& = | KB 2

@ Deployment Tool Complker | Times Found | Date Found

---I:I Installation Files ~ Ll 3 10{12}2009 7:32:51 PM

- (1 Product Configurations + iz 3 10{12{2009 7:32:51 FM

E"""J Metwork Places o 3 3 10/12/2009 7:32:51 PM

~ LwMS 3 10§12{2009 7:32:51 PM

ity WORKGROUP
[]--@ Ackive Directory Daormains
-] Reports

Select one or more computers in the results pane, right-click on one of the highlighted
computers to bring up the context menu. It is recommended that you click on Refresh
Details first, to ensure that necessary requirements are in place for other tasks.

Refresh Details

Install Software. ..
IIpdate Host Setkings. ..
Restart Camputer
Remove Software. ..

&ll Tasks 3

Mew Window from Here

Delete

Properties

Help

Refresh Details

Click Refresh Details to refresh the deployment details for the selected computer(s).
Check to see if a version of the software you are interested in deploying is already on the
target computer(s). Also, check to see if the prerequisites for deployment are met (click
on show details to see the state of specific requirements, including access to WMI and
RPC (IPC$). If prerequisites for deployment are met, the Can Deploy? field will indicate
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"Yes". If these are not met, you must enable them in order for the Deployment Tool to
access the remote computer (see "Target computer requirements").

A prompt for credentials may appear, if you are not logged in with the proper credentials
to view or modify one or more of your network computers. It is recommended that you
use domain administrator credentials with the Deployment Tool (see "Operating
requirements").

65 File  Action  View ‘Window Help | 18]l
€| 2

@ Deployment Tool ﬂ
-2 Installation Files
[:l Product Configurations Com pUter: DEMO\VM 1

E--h} Mebwark Places

Basic Information
Host version 6.10.1409
Master version 6.10.1409
L ey s .
oy WORKGROLP Gateway version 6.10.1409
[]--@ Active Directory Domains Can DED'OY? Yesg
-] Reports

Details of "Can Deploy?"

Is WMI available? Yes

Is WMI Installer available? |Yes

Is IPCS share available? Yes

Is ADMINS share available? |Yes

Installer version 3.1.4000.4042

Click to show details for "Can Deploy", or click to hide
details.

Actions for selected computer:

» Click to Refresh Details about computer

» Click to Install Software to computer

|Dc-ne

Install Software

If the Can Deploy? field value is "Yes", then you can proceed to install software on that
target computer. Click Install Software to install one of your configurations on the selected
computer. The Install Software window appears.
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Install Software [ 7] |

General |

|nztallation File Mame:

IE:'\DDcuments and S ettingz‘\Adminiztrator Host, msi j

— Select modifications ta install

™ Mo additional modifications

™ Transform File Mame:

IE:'\D::u:uments and Settings\.ﬁ.dministratnr'\Desktnp'\P‘rD:-:y-v?-j

= Configuration Mame:

— Computer Restart Options

% Restart after install, if required
= Do not restart after inztall

 Force restart, even if not required

k. I Cancel Help

€ To install a default .msi configuration file for either Host, Master, or Gateway on the
selected computer, select the preloaded Installer file under Installation File Name, and
select No additional modifications.

4 To install a customized .msi configuration file for Host, Master, or Gateway on the
selected computer, select the preloaded Installer file under Installation File Name, and
select a preloaded Product Configuration file under Configuration Name.

& Toinstall an .mst configuration file for Host, Master, or Gateway on the selected
computer, create an .mst file from your custom Product Configuration file. Then select
the Installer file under Installation File Name, and select the Windows Installer Transform
file under Transform File Name.

Select one of the Computer Restart Options before clicking OK.

The Deployment Tool will proceed to deploy the specified Installer file with any additional
modifications, and will generate a deployment report that will appear under Reports.

Update Host Settings

If the Host is installed on the target computer(s), the Deployment Tool can be used to
change Host settings without having to reinstall the Host software itself (e.g. add a
Gateway entry to Gateway tab on one or more target computers).

Follow these steps to update Host settings:
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1 Create a new Product Configuration file and include the new Host settings you wish to
push to the target computer(s) (see "Product Configurations")

2 Click Update Host Settings and in the popup dialog box, select the Product
Configuration file you created above in the dropdown box next to Configuration Name.

3 By default, the Host is set to listen on port 1505 over TCP/IP; if the Host on the remote
computer you are trying to reach has been configured to listen on a different protocol/port
combination, enter the new values.

4 You should be using a domain account that has administrative rights on the remote
computer you are trying to reach (such as Domain Administrator credentials). If the Host
on the target computer is configured for simple password authentication, you can enter
the password here.

5 Click OK to push the Host settings specified in the Product Configuration file to the
target computer.

Update tostsettngs K|

General |

Configuration
Marne:

Prokocol: ITCF‘,I'IP j Part: I <Standard = j

If the target Hosk(s) are configured For Windows
Authentication, wou should run the Deployment Taol as a user
who has administrative rights an the Host, In this case, no
password is required and no credentials prompts will appear.

If the kargek Hosk(s) are configured For simple passwaord, wou
should enter the simple administration password {not the
conneck password) below,

Admin
Passwiord: I

O I Zancel Help

Restart Computer

Click Restart to restart the target computer.

Remove Software
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Click Remove Software to remove the Host, Master, or Gateway on the selected
computer. The Remove Software window appears. Select the product to remove and
click OK. The Deployment Tool will attempt to uninstall and delete any Installer files or
Windows Installer Transform files corresponding to the type of software you have
selected.

Removesoftware |

General |

Praduct Marne:

(] I Cancel Help

Upgrade Software

If older version of software is installed on target computer(s), and a newer version is
loaded into the Deployment Tool, the Deployment Tool will attempt to execute a product
upgrade when Install Software is selected.

If No additional modifications is selected, existing configuration settings will be
retained, while new product configuration values are specified for new features. If either a
Transform file or Product Configuration file is specified, new settings will replace existing
settings during the upgrade.
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Active Directory Domains

Once you have loaded your Installer file(s) and/or your Windows Installer Transform
file(s), you can go to Active Directory Domains to specify the list of target computers for
deployment. Once you select the target computers, you can use the Deployment Tool to
install, uninstall Host or Master software or push configuration settings.

Specify target computers for install or uninstall

Active Directory Domains uses Active Directory to discover and provide access to remote
computers in your domain or in a foreign domain that you specify.

To list the domains in your domain, right-click Active Directory Domains and select
Refresh Local Domains. To list the domains in a foreign domain, right-click Active
Directory Domains and select Add Foreign Domains... Enter domain credentials to get
access to the foreign domain.

Any domains discovered will appear in the lefthand navigation window:
& The left pane provides each domain

€ The right pane provides the name of each domain, along with additional columns for
the number of times it was found, the date it was found, and the number of computers in
it.
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...'--j'-’r Deployment Tool =]
@ File  Action Yiew  Window  Help | o |5’|£|
e = | B2
@ Deplovment Tool Domain | Tvpe | Compukers |
-1 Installation Files (& Computers All Computers in Domain Rook 42
|:| Product Configurations Domain Controllers Crganizational Uit 2
5 g Net.wcurk.PIaces _ (&3] Test Machines rganizakional Unit a
El . Ackive Direckary Domains adrministeatian Organizational Lrit o
El---f_d TestDomain. corm
(€3] Computers
(€8 Domain Contrallers
[£5] Test Machines
{€5] Administration
-2 Reports
4| | i

To obtain information about the computers in a domain, right-click the domain and select
Refresh Organizational Units and Computers. Then expand the domain to see the
computers in it.

...'-j'ﬂ" Deployment Tool =]
@ File Action Yew Window Help | =] =]
& = | B2
@ Deplovment Tool Domain  # | Tvpe Times F... | Date Found |
---[:I Installation Fi_les _ g HP Computer z 10/9/2009 1:25:18
- Product Configurations f P Computer z 10/9/2009 1:25:15
: g Metwork Places _ f YISTA Computer z 10/9)2009 1:25: 13
-5 fctive Directory Domains o YISTAL Computer z 10/9/2003 1:25:18
g% ésm':'ma'”'mm 4 ¥M-TEST Computer z 10/5/2009 1:25:18
= g”mpf-'t‘;’:rs - J vM-DEY Computer 5 10/2/2003 1:25:18
omain Lontreiers J ¥M-DoC Computer 2 10/9j2009 1:25:15
(€3] Test Machines
: n . J YM-P10 Camputer 2 10/9/2009 1:25:15
(€3] Administration J
-] Reports f WM-FS Computer z 10//2009 1:25:15
-J WM-PS1 Compuker z 10/9/2009 1:25:18
-J WM-P& Computer z 10/9/2009 1:25:15
-J WM-SRY Compuker z 10/9/2009 1:25:18
a | i

Select one or more computers in the results pane, right-click on one of the highlighted
computers to bring up the context menu. It is recommended that you click on Refresh
Details first, to ensure that necessary requirements are in place for other tasks.
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Refresh Details

Install Software. ..
Ilpdate Hosk Settings...
Restart Compuker
Remove Software. ..

all Tasks 3

Mew Windaw From Here

Delete

Properties

Help

Refresh Details

Click Refresh Details to refresh the deployment details for the selected computer(s).
Check to see if a version of the software you are interested in deploying is already on the
target computer(s). Also, check to see if the prerequisites for deployment are met (click
on show details to see the state of specific requirements, including access to WMI and
RPC (IPC$). If prerequisites for deployment are met, the Can Deploy? field will indicate
"Yes". If these are not met, you must enable them in order for the Deployment Tool to
access the remote computer (see "Target computer requirements").

A prompt for credentials may appeatr, if you are not logged in with the proper credentials
to view or modify one or more of your network computers. It is recommended that you
use domain administrator credentials with the Deployment Tool (see "Operating
requirements").
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Z Deployment ool @A
B2 File Action Wiew Window Help | o -l |
= | B @
@ Deployment Tool ;I
[ Installation Files .
D Product Configurations Com pUter'
- Metwork Places
Elé Active Directory Domains VM 1 'TEST DO MAI N 'com
[l TestDamain,com
B8] Computers
----- 4 HP : :
..... o Basic Information
""" i VISTA Host version 6.10.1409
:j liesl Master version 6.10.1409
----- '§ WM-DEW Gateway version 6.10.1409
:j mfoc Can Deploy? Yes
----- g WM-PS
:j mggl Details of "Can Deploy?"
_____ o M-SRy Is WMI available? Yes
EJ“% Domain Cﬁntm”efs Is WMI Installer available? |Yes
@ s Mahites Is IPC$ share available?  |Yes
B[ Reports Is ADMINS share available? |Yes
Installer version 3.1.4000.4042
Click to show details for "Can Deploy", or click to hide
details.
Actions for selected computer:
» Click to Refresh _Details about computer
Jid

|D0ne

Install Software

If the Can Deploy? field value is "Yes", then you can proceed to install software on that
target computer. Click Install Software to install one of your configurations on the selected
computer. The Install Software window appears.
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Install Software [ 7] |

General |

|nztallation File Mame:

IE:'\DDcuments and S ettingz‘\Adminiztrator Host, msi j

— Select modifications ta install

™ Mo additional modifications

™ Transform File Mame:

IE:'\D::u:uments and Settings\.ﬁ.dministratnr'\Desktnp'\P‘rD:-:y-v?-j

= Configuration Mame:

— Computer Restart Options

% Restart after install, if required
= Do not restart after inztall

 Force restart, even if not required

k. I Cancel Help

€ To install a default .msi configuration file for either the Host, Master, or Gateway on
the selected computer, select the preloaded Installer file under Installation File Name, and
select No additional modifications.

4 To install a customized .msi configuration file for the Host, Master, or Gateway on the
selected computer, select the preloaded Installer file under Installation File Name, and
select a preloaded Product Configuration file under Configuration Name.

€ To install an .mst configuration file for the Host, Master, or Gateway on the selected
computer, create an .mst file from your custom Product Configuration file. Then select
the Installer file under Installation File Name, and select the Windows Installer Transform
file under Transform File Name.

Select one of the Computer Restart Options before clicking OK.

The Deployment Tool will proceed to deploy the specified Installer file with any additional
modifications, and will generate a deployment report that will appear under Reports.

Update Host Settings

If the Host is installed on the target computer(s), the Deployment Tool can be used to
change Host settings without having to reinstall the Host software itself (e.g. add a
Gateway entry to Gateway tab on one or more target computers).

Follow these steps to update Host settings:
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1 Create a new Product Configuration file and include the new Host settings you wish to
push to the target computer(s) (see "Product Configurations")

2 Click Update Host Settings and in the popup dialog box, select the Product
Configuration file you created above in the dropdown box next to Configuration Name.

3 By default, the Host is set to listen on port 1505 over TCP/IP; if the Host on the remote
computer you are trying to reach has been configured to listen on a different protocol/port
combination, enter the new values.

4 You should be using a domain account that has administrative rights on the remote
computer you are trying to reach (such as Domain Administrator credentials). If the Host
on the target computer is configured for simple password authentication, you can enter
the password here.

5 Click OK to push the Host settings specified in the Product Configuration file to the
target computer.

Update tostsettngs K|

General |

Configuration
Marne:

Prokocol: ITCF‘,I'IP j Part: I <Standard = j

If the target Hosk(s) are configured For Windows
Authentication, wou should run the Deployment Taol as a user
who has administrative rights an the Host, In this case, no
password is required and no credentials prompts will appear.

If the kargek Hosk(s) are configured For simple passwaord, wou
should enter the simple administration password {not the
conneck password) below,

Admin
Passwiord: I

O I Zancel Help

Restart Computer

Click Restart to restart the target computer.

Remove Software
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Click Remove Software to remove the Host, Master, or Gateway on the selected
computer. The Remove Software window appears. Select the product to remove and
click OK. The Deployment Tool will attempt to uninstall and delete any Installer files or
Windows Installer Transform files corresponding to the type of software you have
selected.

Removesoftware |

General |

Praduct Marne:

(] I Cancel Help

Upgrade Software

If older version of software is installed on target computer(s), and a newer version is
loaded into the Deployment Tool, the Deployment Tool will attempt to execute a product
upgrade when Install Software is selected.

If No additional modifications is selected, existing configuration settings will be
retained, while new product configuration values are specified for new features. If either a
Transform file or Product Configuration file is specified, new settings will replace existing
settings during the upgrade.
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Reports

The Deployment Tool generates a brief summary for each action taken in either Network
Places or Active Directory Domains, and stores the summary in a time-stamped folder
under Reports.

The Reports folder can contain summaries for each of the five different types of action
available, including:

& Computer Details folder which shows results of Refresh Details action.

€ Software Installations folder which shows results of Install Software action.

€ Remove Software folder which shows results of Remove Software action.

@ Restart Computer folder which shows results of Restart Computer action.

€ Update Host Settings folder which shows results of Update Host Settings action.

In the example, below, a summary of a successful Refresh Details action for computer
VM1 in the TestDomain domain is shown:

J-E" Deployment Tool _ (O] |
@ File  Action Wiew Window Help |_|_|- =3 il

= BHmEXB|@mE

@ Deployment Taool [ame I Host Version I Masker Version I Can Deploy? | Progress

-2 Product Configurations
() netwark Places
- Ackive Directory Domains
E|D Reports
B[] Computer Details
T L0 0:17 P
(I3 10/13}2009 £:51:38 FM
£ Restart Computer
(I3 104132009 6:59:24 PM
E| [C Update Host: Settings
[T 10f13/2009 6:59:49 PM
ED Remove Software

(] 10413/2009 7:01:37 PM

{1 Installation Files 55 yh 1 TestDomain.com  6.10,1505 7.0.1506 Yfes Completed
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Troubleshooting tips are provided for the following issues:

4 "Authentication failure"

€ "Trouble installing software or refreshing details on Windows XP"
€ "Trouble installing/removing software to/from a computer"

4 "Generate unique HostIDs"
*

"Remove duplicate HostIDs"

Authentication failure

If you experience authentication failure, carefully check your authentication credentials.
You must have administration rights on the target computer to install software.

Trouble installing software or refreshing details on
Windows XP

The local security policy Network access: Sharing and security model for local accounts
can prevent remote access to the administrative shares and WMI.

It is possible that you cannot refresh details or install the software on a target networked
Windows XP computer that is a workgroup member.

See “Target computer requirements” for the correct configuration details.

Trouble installing/removing software to/from a computer

If you address all requirements in “Target computer requirements”, you should not have
any problems installing or removing software.

If you are unable to install or remove software from a target computer, confirm that the
following are installed and active on the target computer:

& Microsoft Networking IPC$ share: Check that this share is displayed on the target
computer.

€ Microsoft Networking ADMINS share: Check that this share is displayed on the target
computer. To do this, open Windows Explorer and type \\<target_machine>\admin$ and
check to see that you don’t get any type of access error.

€ Windows Management Instrumentation (WMI): Check that the WMI service is started.
You can test that the target machine has WMI available and installed properly by using
Microsoft's built-in tool WMIC. In a command prompt, type "WMIC". From the resulting
prompt, type the following command to confirm WMI access:

wmic /node:<target machine> /user.<username> /password:<password>
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¢ WMI Windows Installer Provider: This is an option for Windows Server 2003. See
“WMI Windows Installer Provider installation” for information on how to install this option.

Note: "Error: WMI: Provider load failure (0x80041013)" and "Error: WMI: Invalid class
(0x80041010)" are indicative of the optional "WMI Windows Installer Provider" not being
installed on Windows Server 2003. Go to Add or Remove Programs, Add/Remove
Windows Components, Management and Monitoring Tools, Details and check WMI
Windows Installer Provider.

Generate unique HostIDs

Each Host installation is identified by a unique identifier, called the HostID. This identifier
is used by the Gateway to identify a Host, even as other information about the Host, such
as the machine name, may change. This identifier contains no additional information and
has no use other than to allow the Gateway to identify individual Hosts on the network.
The HostID is a GUID, a 16-byte number with a text representation like “{C8E645A4-
AF10-46f7-838B-A75105C8AA13}".

Issues arise with operating system imaging, the process by which an operating system is
installed on one machine and then replicated to other remote computers. Typically, a
third-party utility program, such as Symantec Norton Ghost™ or PowerQuest Drive
Image, is used for operating system imaging.

If the Host is installed on an operating system that is then imaged, all of the remote
computers will end up with the same HostID. The Gateway will recognize the first Host it
sees with this HostID, but ignore any others with the same HostID. The result is that
many Hosts will not show up in the Gateway directory.

There are two strategies for dealing with this issue:

€ The preferred solution is to prepare the Host installation for imaging before creating
the operating system snapshot to be duplicated. Just as you use the Microsoft-provided
“SysPrep” utility to prepare the operating system, you can use the Host “HostPrep” utility
to prepare the Host before imaging. This is described in the next section.

¢ If a deployment has been completed and duplicate HostIDs exist on the network, the
Host “RmHostID” utility can be used to remove the duplicate HostIDs and cause the
affected remote computers to be assigned a new (and unique) ID. This is described later
in this document.

Prepare the Host and operating system for imaging

The Host includes a utility program named hostprep.exe to address issues with
operating system imaging. The Hostprep utility is available in the Utilities file.

To avoid the problem of having duplicate HostIDs, you must run the hostprep utility to
delete the ID before the operating system image is captured.

NOTE: You must prepare the Host software for imaging just before you use the
Microsoft-provided SysPrep utility to prepare the operating system.

After the machine is set up and all Host settings are configured, and immediately before
running the Microsoft-provided SysPrep utility, run the hostprep.exe utility from a
command prompt. The optional command line argument “~y” can be used to avoid a
prompt to continue. When HostPrep runs, it stops the Host service and prepares the Host
for imaging. It is critical that the Host service not restart before the operating system
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image is captured because when the Host starts, it undoes the actions completed by the
HostPrep utility.

For more information about operating system imaging, please see the Microsoft TechNet
Desktop Deployment Center at

http://www.microsoft.com/technet/desktopdeployment/

HostPrep command line syntax

HostPrep accepts a command line flags that control its behavior:

4 -y do not ask for confirmation; default is to prompt before continuing

& -yes same as -y’

4 -guid deletes the HostID only, but does not prepare the settings

& -restart restarts the Host Service when compute; should only be used with ‘-guid’

To prepare an installation for imaging, run hostprep.exe with no arguments, and press

the “y” key when prompted.

To delete the HostID on the local computer and cause a new one to be assigned
immediately, run the command line “hostprep.exe —-guid -restart”.

HostPrep runs on all of the operating systems supported by the Host.

Remove duplicate HostIDs
The RmHostID utility is available in the Utilities file.

The RmHostID utility runs on one computer and searches one or more computers for
Host installations that have a specified HostID. If a matching HostID is found, the HostID
is deleted and the Host Service restarted so that a new ID will be assigned. This utility
can be used to “clean up” Host installations with duplicate IDs on a LAN.

RmHostID command line syntax

RmHostID accepts command line flags that control its behavior:
& -p prompt for confirmation before deleting HostID

& -prompt same as ‘-p’

& -? displays help text describing how to use RmHostID

RmHostID expects two arguments (in addition to any flags) on its command line. The first
argument specifies which HostIDs should be considered duplicates, and therefore should
be deleted. The second argument specifies which machine or remote computers should
be examined.

The HostID specification (first argument) can be one of:
@ A specific GUID, in the form “{C8E645A4-AF10-46f7-838B-A75105C8AA 13}’
& A star (“*"), signifying that all HostIDs found should be deleted

€ An at sign (“@”) followed immediately by a filename. This causes the specified file to
be read, and each line should contain a single GUID.

The machine’s specification (second argument) can be one of:
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& If the machine specification is missing, the local machine is checked
€ A specific machine name, as either a NetBIOS machine name or a DNS name

& A star (“*”), which instructs RmHostID to enumerate all remote computers on the
network

€ An at sign (“@”) followed immediately by a filename. This causes the specified file to
be read, and each line should contain a single machine name (as either a NetBIOS
machine name or a DNS name).

Examples:
¢ RmHostld {078A9A01-6931-42A3-9371-EAO00F1DC7D99} *

This example enumerates the remote computers on the network, and deletes the HostID
of any installations that match the specified ID.

4 RmHostld {078A9A01-6931-42A3-9371-EAO0F1DC7D99} MACHINEO4

This example connects to the one machine named “Machine04”, and deletes the HostID
on that machine if and only if it matches the specified ID.

¢ RmHostld * MACHINEO4

This example connects to the one machine “Machine04”, and deletes the HostID
unconditionally, because “*” was specified as the HostID pattern.

4 RmHostld GUIDS. TXT *

This example enumerates the remote computers on the network, and deletes the HostID
of any installations that match any of the IDs specified in the GUIDS.TXT file.

& Example GUIDS. TXT file:
+ {078A9A01-6931-42A3-9371-EAO0F1DC7D99}
+ {078A9A02-6931-42A3-9371-EAO0F1DC7D99}

Requirements for RmHostID

The user must be logged in as Administrator, or otherwise have access permissions to
the ADMINS share on the Host remote computers.

The Host remote computers must allow remote access to the Service Control Manager
and to the Registry. Typically, this means that Microsoft File & Printer Sharing is enabled
and that these services are not blocked by a firewall.

Enumerating remote computers on the network with “*” can take some time; this utility
uses the same algorithm and APIs to enumerate the network as the Deployment Tool.

Host GUIDs can be obtained by copying from:

& the Host Control Panel Gateways tab

& the Gateway Administrator Host Properties General tab

& the registry on an affected machine in HKCR\Proxy.Host\HostID\GUID
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